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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer
“Documentation” means information published by Avaya in varying
mediums which may include product information, operating
instructions and performance specifications that Avaya may generally
make available to users of its products and Hosted Services.
Documentation does not include marketing materials. Avaya shall not
be responsible for any modifications, additions, or deletions to the
original published version of documentation unless such
modifications, additions, or deletions were performed by Avaya. End
User agrees to indemnify and hold harmless Avaya, Avaya's agents,
servants and employees against all claims, lawsuits, demands and
judgments arising out of, or in connection with, subsequent
modifications, additions or deletions to this documentation, to the
extent made by End User.

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: http://support.avaya.com or such successor site as
designated by Avaya. Please note that if You acquired the product(s)
from an authorized Avaya Channel Partner outside of the United
States and Canada, the warranty is provided to You by said Avaya
Channel Partner and not by Avaya.

“Hosted Service” means a hosted service subscription that You
acquire from either Avaya or an authorized Avaya Channel Partner
(as applicable) and which is described further in Hosted SAS or other
service description documentation regarding the applicable hosted
service. If You purchase a Hosted Service subscription, the foregoing
limited warranty may not apply but You may be entitled to support
services in connection with the Hosted Service as described further
in your service description documents for the applicable Hosted
Service. Contact Avaya or Avaya Channel Partner (as applicable) for
more information.

Hosted Service
THE FOLLOWING APPLIES IF YOU PURCHASE A HOSTED
SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR
IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU

MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE. YOUR USE OF THE HOSTED SERVICE SHALL BE
LIMITED BY THE NUMBER AND TYPE OF LICENSES
PURCHASED UNDER YOUR CONTRACT FOR THE HOSTED
SERVICE, PROVIDED, HOWEVER, THAT FOR CERTAIN HOSTED
SERVICES IF APPLICABLE, YOU MAY HAVE THE OPPORTUNITY
TO USE FLEX LICENSES, WHICH WILL BE INVOICED
ACCORDING TO ACTUAL USAGE ABOVE THE CONTRACT
LICENSE LEVEL. CONTACT AVAYA OR AVAYA’S CHANNEL
PARTNER FOR MORE INFORMATION ABOUT THE LICENSES
FOR THE APPLICABLE HOSTED SERVICE, THE AVAILABILITY
OF ANY FLEX LICENSES (IF APPLICABLE), PRICING AND
BILLING INFORMATION, AND OTHER IMPORTANT
INFORMATION REGARDING THE HOSTED SERVICE.

Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO OR
SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, ARE
APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR
INSTALLS AVAYA SOFTWARE, PURCHASED FROM AVAYA INC.,
ANY AVAYA AFFILIATE, OR AN AVAYA CHANNEL PARTNER (AS
APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH
AVAYA OR AN AVAYA CHANNEL PARTNER. UNLESS
OTHERWISE AGREED TO BY AVAYA IN WRITING, AVAYA DOES
NOT EXTEND THIS LICENSE IF THE SOFTWARE WAS
OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License. The
applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the documentation or other
materials available to You. “Software” means computer programs in
object code, provided by Avaya or an Avaya Channel Partner,
whether as stand-alone products, pre-installed on hardware products,
and any upgrades, updates, patches, bug fixes, or modified versions
thereto. “Designated Processor” means a single stand-alone
computing device. “Server” means a Designated Processor that
hosts a software application to be accessed by multiple users.
“Instance” means a single copy of the Software executing at a
particular time: (i) on one physical machine; or (ii) on one deployed
software virtual machine (“VM”) or similar deployment.

Licence types
Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only on a number of
Designated Processors up to the number indicated in the order.
Avaya may require the Designated Processor(s) to be identified in
the order by type, serial number, feature key, Instance, location or
other specific designation, or to be provided by End User to Avaya
through electronic means established by Avaya specifically for this
purpose.

Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
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with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.

Named User License (NU). You may: (i) install and use the Software
on a single Designated Processor or Server per authorized Named
User (defined below); or (ii) install and use the Software on a Server
so long as only authorized Named Users access and use the
Software. “Named User”, means a user or device that has been
expressly authorized by Avaya to access and use the Software. At
Avaya’s sole discretion, a “Named User” may be, without limitation,
designated by name, corporate function (e.g., webmaster or
helpdesk), an e-mail or voice mail account in the name of a person or
corporate function, or a directory entry in the administrative database
utilized by the Software that permits one user to interface with the
Software.

Shrinkwrap License (SR). You may install and use the Software in
accordance with the terms and conditions of the applicable license
agreements, such as “shrinkwrap” or “clickthrough” license
accompanying or applicable to the Software (“Shrinkwrap License”).

Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization
Each product has its own ordering code and license types. Note that
each Instance of a product must be separately licensed and ordered.
For example, if the end user customer or Avaya Channel Partner
would like to install two Instances of the same type of products, then
two products of that type must be ordered.

Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: http://
support.avaya.com/Copyright or such successor site as designated
by Avaya. You agree to the Third Party Terms for any such Third
Party Components.

Note to Service Provider
The product or Hosted Service may use Third Party Components
subject to Third Party Terms that do not allow hosting and require a
Service Provider to be independently licensed for such purpose. It is
your responsibility to obtain such licensing.

Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see

the Avaya Support website: http://support.avaya.com or such
successor site as designated by Avaya. Suspected security
vulnerabilities with Avaya products should be reported to Avaya by
sending mail to: securityalerts@avaya.com.

Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: http://support.avaya.com, or such successor site as
designated by Avaya.

Contact Avaya Support
See the Avaya Support website: http://support.avaya.com for product
or Hosted Service notices and articles, or to report a problem with
your Avaya product or Hosted Service. For a list of support telephone
numbers and contact addresses, go to the Avaya Support website: 
http://support.avaya.com (or such successor site as designated by
Avaya), scroll to the bottom of the page, and select Contact Avaya
Support.

Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, or other third parties. Users are not permitted to use such
Marks without prior written consent from Avaya or such third party
which may own the Mark. Nothing contained in this site, the
Documentation, Hosted Service(s) and product(s) should be
construed as granting, by implication, estoppel, or otherwise, any
license or right in and to the Marks without the express written
permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Getting Started

Messaging overview
With Avaya Aura® Messaging, you can manage your calls, voice messages, and fax messages on
any device including tablets, smart phones, deskphones, and computers. Messaging offers an
intuitive interface and a rich set of features for users to enhance productivity. Messaging provides
the required flexibility, resilience, and scale in to fit into demanding environments.

Prerequisites
Get the following Messaging information from the administrator:

• The Messaging access number

• The mailbox number and a temporary password

• The URL to gain access to the Avaya Aura® Messaging User Preferences webpage

Telephone user interface overview
A telephone user interface (TUI) makes human interaction with computers possible through a voice
or speech platform that starts an automated service or process. Messaging offers the following TUIs
that support many features and menus of the original TUIs. :

• Aria TUI for Messaging: The Aria TUI supports many features and menus of traditional Octel
Aria systems.

• Audix TUI for Messaging: The Audix TUI supports many features and menus of traditional
Audix and Intuity Audix systems.

• CallPilot TUI for Messaging: The CallPilot TUI supports many features and menus of traditional
CallPilot and Meridian Mail systems.

Note:

Your TUI preferences takes effect only after you log in to Messaging.
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Accessing your mailbox from any phone
About this task
You can go to your mailbox from anywhere by dialing one of the Messaging access numbers. You
can also dial the Automated Attendant, if your organization allows Automated Attendant to access
the Messaging system.

Procedure
1. Perform one of the following actions:

• From any external phone, dial the Messaging access number (external) and press the
pound key (#).

• On a phone belonging to another Messaging user within your organization, dial the
Messaging access number. Then, if you are an Aria user press star (*). Otherwise, press
the pound key (#).

• Dial the Automated Attendant number of your organization, and press the pound key (#).

2. Enter your mailbox number, and press the pound key (#).

The system announces your name and prompts you to enter your password.

3. Enter your password, and press the pound key (#).

Accessing the mailbox from your desk phone or soft
phone

Before you begin
Ensure that you have your Messaging access number. If not, contact your administrator.

Procedure
1. From your office deskphone or softphone, do one of the following:

• Press the Voice mail or Message button.
• Dial the Messaging access number (internal).

The system announces your name and prompts you for your password.

2. Enter your Messaging password and then press the pound key (#).

Initializing your mailbox
Before you begin
Ensure that the administrator configured the settings for your mailbox.

Getting Started
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About this task
Initialize your mailbox using TUI to receive voice mail.

To initialize your mailbox:

• Change your temporary password.
• Record your name: Messaging uses your recorded name to identify you to other Messaging

users. The system also uses your recorded name in the system-generated greeting that TUI
plays when callers reach your mailbox. If your organization uses the Messaging automatic
attendant, TUI plays your recorded name before the attendant transfers callers to your
extension. If you do not record your name, TUI plays the Text-to-Speech (TTS) version of your
name.

• Record your personal greeting: Messaging plays greeting to callers when your phone is busy or
you do not answer a call. If you do not record a greeting, Messaging uses your recorded name.
If you do not record a greeting, TUI plays the TTS version of the system-generated greeting.

Important:
The mailbox initialization process depends on the TUI that your administrator configured for
your mailbox and your user account. The mailbox initialization process also depends on the
value of the system settings that your administrator sets for your mailbox and your user account.

If you initialized your mailbox earlier, but cannot log in, get a temporary password from the
administrator.

Procedure
1. Call Messaging using TUI.

2. Enter your temporary password that the administrator assigns you while creating your
mailbox, and press the pound key (#).

If you changed your temporary password on the Password page in User Preferences, use
your new password or follow the prompts.

3. Follow the prompts to change your password.

4. (Optional) Follow the prompts to record your name.

If the administrator configured Messaging to prevent sending messages to uninitialized
mailboxes, you can perform this step later.

5. (Optional) Follow the prompts to record your personal greeting.

If the administrator configured Messaging to prevent sending messages to uninitialized
mailboxes, you can perform this step later.

Next steps
To record your name or a personal greeting or both, in absence of the TUI prompts, see the TUI
Quick reference for the required commands.

Initializing your mailbox
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Logging in to User Preferences
About this task
You can configure options for various Messaging features through the User Preferences webpage.

Procedure
1. To open the User Preferences webpage, perform one of the following:

• Click User Preferences on the Messaging toolbar in Outlook.

• Open a web browser, in the address bar type the URL for User Preferences that your
system administrator provided and press enter.

The system displays the Messaging User Preferences login page.

2. In the Mailbox number field, type your mailbox number.

3. In the Messaging password field, type your password.

4. Click Log In.

The system displays the User Preferences General webpage.

Next steps
Customize your General preferences. For more information, see General preferences on page 37.

Getting Started
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Chapter 2: Messaging from your e-mail
client

The Messaging toolbar
The Messaging toolbar is a set of feature buttons that you can use to access your voice messages
from your Outlook email client.

The Messaging toolbar is only available for voice messages created by Avaya Aura® Messaging. If
you set up your User Preferences to receive a Notify Me email copy of each voice message, the
copies will appear in your designated email Inbox, but the Messaging toolbar will not be available for
these emails.

The Messaging toolbar has the following features:

• Play on PC

• Play on Phone

• Voice Reply

• Voice Forward

• Call Sender

• User Preferences

• Help

Prerequisite for playing a voice message
Ensure that your web browser has pop-ups enabled for internal web servers, since some features
(Play on Phone, Voice Reply, Voice Forward, and Call Sender) require pop-ups.

Play on PC
Play on PC allows you to play a voice message on your computer.
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Using Play on PC
Before you begin
Your system must have Windows Media Player 9 or later. To update or install the latest version of
Windows Media Player, see http://www.microsoft.com/windows/windowsmedia/.

Procedure
1. On the Messaging toolbar, click Play on PC for an open voice message .

2. Perform one or more of the following:

• Use the Pause, Resume, Stop, Rewind, and Forward buttons to control playback. The
Rewind and Forward buttons either rewind or advance the message by10 seconds.

• Adjust the volume on your computer speakers or headset as required.

Play on Phone
Use Play on Phone to listen to your voice message on a telephone.

Using Play on Phone for the first time
About this task
When you use Play on Phone for the first time, you must provide your Messaging mailbox number to
associate it with your email identity. You need to perform this task only once.

Procedure
1. In the Avaya Voice Message—Play on Phone window, in the Mailbox number field, type

your mailbox number.

2. Click Save.

Related Links
Clearing the mailbox number association on page 57

Using Play on Phone
Before you begin
Ensure that you complete the task, Using Play on Phone for the first time on page 12 to associate
the Messaging mailbox number with your email identity.

About this task
Use this procedure to perform various tasks using Play on Phone feature on the Messaging mailbox
of your email client.

Procedure
1. Open your voice message with your email client, and then navigate to the Avaya Voice

Message toolbar.

Messaging from your e-mail client
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2. To listen to a voice message from your inbox or from the Outlook mail folder, right-click the
voice message.

• For Outlook 2003, 2007: Click Play on Phone.

• For Outlook 2010, 2013: Click Custom Actions  > Play on Phone.

The system displays the Phone number selection window unless you previously selected
Always use this phone number. See Step 3.

3. Select the phone that you want to use to play the message.

• Click Extension to use your extension.

• Click Mobile to use your mobile phone. You can choose this option if you enter a mobile
number on the Mobile Phone or Pager field on the User Preferences  > General page.

• Click Other to enter another number.

Note:

Click Always use this phone number to always use the selected phone number for
Messaging toolbar feature operations. You may reset this option in the Play on Phone
section of the User Preferences  > General page.

4. Click Call.

The system calls the selected number and displays the Call Progress window.

5. Answer the phone and enter your password at the prompt.

The system plays the voice message.

Voice Reply
Use the Voice Reply feature to reply to voice messages received from users in your organization’s
voice mail system.

Using Voice Reply
Procedure

1. Use your email client to open your voice message and then navigate to the Messaging
toolbar.

2. Click Voice Reply.

The system displays the Phone number selection window (unless you previously selected
Always use this phone number. See step 3).

3. Select the phone you want to use to send a voice reply.

• Select Extension to use your extension.

• Select Mobile to use your mobile phone. You can choose this option only if your
administrator has populated the mobile phone field.

The Messaging toolbar
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• Select Other Mobile to use another mobile phone. You can choose this option if you have
entered a mobile number on the Other mobile phone or pager field on the User
Preferences > General page.

Note:

Avaya Aura® Messaging supports only email based (SMTP) pager notifications.

• Select Other to manually enter a number.

Select Always use this phone number to always use your selected phone number for
Messaging toolbar feature operations. You may reset this option on the User Preferences >
General page, Play on Phone section.

4. Click Call.

The system calls the selected number and displays the Call Progress window.

5. Answer the phone and enter your password, when prompted.

6. Record your voice reply.

Voice Forward
Use the Voice Forward feature to forward voice messages to callers in your organization’s voicemail
system. You can attach a voice introduction to the message being forwarded.

Using Voice Forward
Procedure

1. Use your email client to open your voice message and then navigate to the Messaging
toolbar.

2. Click Voice Forward.

The system displays the Phone number selection window (unless you previously selected
Always use this phone number. See step 3).

3. Select the phone you want to use to forward a voice message.

• Select Extension to use your extension.

• Select Mobile to use your mobile phone. You can choose this option only if your
administrator has populated the mobile phone field.

• Select Other Mobile to use another mobile phone. You can choose this option if you have
entered a mobile number on the Other mobile phone or pager field on the User
Preferences > General page.

Note:

Avaya Aura® Messaging supports only email based (SMTP) pager notifications.

• Select Other to manually enter a number.

Messaging from your e-mail client
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Select Always use this phone number to always use your selected phone number for
Messaging toolbar feature operations. You may reset this option on the User Preferences >
General page, Play on Phone section.

4. Click Call.

The system calls the selected number and displays the Call Progress window.

5. Answer the phone and enter your password, when prompted.

6. Select your recipient(s) and follow the prompts to forward your message.

Call Sender
Use the Call Sender feature to call the person who left the voice message in your message box.

Using Call Sender
Procedure

1. Use your email client to open your voice message, and then navigate to the Messaging
toolbar.

2. Click Call Sender.

The system displays the Phone number selection window, unless you previously selected
Always use this phone number. See Step 3.

3. Select the phone that you want to use to call the sender.

• Click Extension to use your extension.

• Click Mobile to use your mobile phone. You can choose this option only if your
administrator has populated the mobile phone field.

• Click Other Mobile to use another mobile phone. You can choose this option if you
entered a mobile number on the Other mobile phone or pager field on the User
Preferences  > General page.

Note:

Avaya Aura® Messaging supports only email-based (SMTP) pager notifications.

• Click Other to manually enter a number.

Click Always use this phone number to always use your selected phone number for
Messaging toolbar feature operations. To reset this option, go to the Play on Phone section
on the User Preferences > General page.

4. Click Call.

The system calls the selected number and displays the Call Progress window, and plays
the Call Progress (ringback) audio simultaneously.

The Messaging toolbar
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Note:

You cannot return to the original call session or Messaging when the call sender process
is complete, regardless of whether the call sender process is successful or fails.

5. Answer the phone and enter your password, when prompted.

The system calls the sender.

Call progress
Messaging automatically reports the call progress when you use Play on Phone, Voice Reply, Voice
Forward, or Call Sender.

The Call progress window automatically closes after 10 seconds.

If the call fails, the system displays the reason for the call failure. The possible reasons for a call
failure are:

• The outgoing line is unavailable.
• The called number is busy or does not answer.
• Dial out privileges are not sufficient.
• The specified number is not a valid number.

Email client (Outlook) configuration
Messaging supports the following message stores:

• The Avaya message store
• The Exchange server

To gain access to the voice messages, you must configure Microsoft Outlook based on the
message store that you use.

• To configure Microsoft Outlook for Avaya message store, set up an IMAP email account in your
Outlook to use voice messages.

The procedures to configure Microsoft Outlook for Avaya message store depend on the
Outlook version.
- Configuring Outlook 2013 for Avaya message store on page 17.
- Configuring Outlook 2010 for Avaya message store on page 18.
- Configuring Outlook 2007 for Avaya message store on page 20.
- Configuring Outlook 2003 for Avaya message store on page 21.

• To configure Microsoft Outlook for Exchange server message store, you can directly use your
designated email account in Microsoft Outlook without any further configuration, to gain access
to the voice messages.

Messaging from your e-mail client
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Note:
The Microsoft Outlook toolbar does not display the messages delivered before the mailbox
configuration in Outlook.

Configuring Outlook 2013 for Avaya message store
Before you begin
Follow this procedure only if the Messaging store type (provided by your administrator) is Avaya
message store. This procedure is not applicable if the Messaging store type is Exchange server.

About this task
To configure Microsoft Office Outlook 2013, perform the following steps:

Procedure
1. Start Outlook.

2. On the File menu, click Info and then click Add Account.

You must create a default Outlook profile and load the default profile in Microsoft Office
Outlook 2013 otherwise, Outlook window closes automatically.

The system displays the Auto Account Setup dialog box.

3. Select the Manual setup of additional server types option, and then click Next.

The system displays the Choose Service dialog box.

4. Select the POP or IMAP option, and then click Next.

The system displays the POP and IMAP Account Settings dialog box.

5. In the Your Name box, type your name, for example Michael J. Smith.

6. In the E-mail Address box, type the email address that you use for your Avaya message
store.

7. In the Server Information section, select IMAP for Account Types.

8. In the Incoming mail server box, type the Messaging server address provided by your
administrator.

9. In the Outgoing mail server (SMTP) box, type the name of your Messaging server address
provided by your administrator. This is the same server as mentioned at the previous step.

Note:

The Outgoing mail server (SMTP) is to be used by Messaging only. Do not send emails
using this account. To send emails, use your designated email account. To reply to voice
messages or to forward them, use the Messaging toolbar.

10. In the User Name box, type your assigned internal identifier.

Email client (Outlook) configuration
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For example, fName.lName.112233 @FQDNOFAAMStorageServer. You must use the entire
local part fName.lName.11223 till @ sign as user name for IMAP.

11. In the Password box, type your Messaging password.

12. Click More Settings….

13. On the General tab, replace the default name for the mail account with Avaya Aura
Messaging or a similar designation to indicate that this is your voice messages mailbox.

14. Click the Advanced tab.

15. Select Auto for Use the following type of encrypted connection for both Incoming and
Outgoing servers in the Server Port Numbers section.

16. Click the Outgoing Server tab.

17. Select the My outgoing server (SMTP) requires authentication check box.

18. Select the Use same settings as my incoming mail server option.

19. Click OK.

20. Click Next when you finish entering this configuration information, and then click Finish.

21. (Optional) You can also add your voice messages mailbox as a favorite folder by performing
the following steps:

a. In Outlook, click the mail folder.

b. To expand the folder, click the plus sign (+).

c. Right-click Inbox, and then select Add to Favorite Folders.

Configuring Outlook 2010 for Avaya message store
Before you begin
Follow this procedure only if the Messaging store type (provided by your administrator) is Avaya
message store. This procedure is not applicable if the Messaging store type is Exchange server.

About this task
To configure Microsoft Office Outlook 2010, perform the following steps:

Procedure
1. Start Outlook.

2. On the File menu, click Info and then click Add Account.

You must create a default Outlook profile and load the default profile in Microsoft Office
Outlook 2010 otherwise, Outlook window closes automatically.

The system displays the Auto Account Setup dialog box.

3. Select the Manually configure server settings or additional server types option, and
then click Next.

Messaging from your e-mail client
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The system displays the Choose Service dialog box.

4. Select the Internet E-Mail check box, and then click Next.

The system displays the Internet E-mail Settings dialog box.

5. In the Your Name box, type your name, for example Michael J. Smith.

6. In the E-mail Address box, type the email address that you use for your Avaya message
store.

7. In the Server Information section, select IMAP for Account Types.

8. In the Incoming mail server box, type the Messaging server address provided by your
administrator.

9. In the Outgoing mail server (SMTP) box, type the name of your Messaging server address
provided by your administrator. This is the same server as mentioned at the previous step.

Note:

• The Outgoing mail server (SMTP) is to be used by Messaging only. Do not send
emails using this account. To send emails, use your designated email account.

• To reply to voice messages or to forward them, use the Messaging toolbar or right-
click on the voice message and click on the appropriate functions under Custom
Actions in the context-sensitive menu.

Tip:

You must use the Outlook 2010 upgraded with latest SP2 for Office 2010 (32-bit),
to view the functions under Custom Actions in the context-sensitive menu.

10. In the User Name box, type your assigned internal identifier.

For example, fName.lName.112233 @FQDNOFAAMStorageServer. You must use the entire
local part fName.lName.11223 till @ sign as user name for IMAP.

11. In the Password box, type your Messaging password.

12. Click More Settings….

13. On the General tab, replace the default name for the mail account with Avaya Aura
Messaging or a similar designation to indicate that this is your voice messages mailbox.

14. Click the Advanced tab.

15. Select Auto for Use the following type of encrypted connection for both Incoming and
Outgoing servers in the Server Port Numbers section.

16. Click the Outgoing Server tab.

17. Select the My outgoing server (SMTP) requires authentication check box.

18. Select the Use same settings as my incoming mail server option.

19. Click OK.

20. Click Next when you finish entering this configuration information, and then click Finish.

Email client (Outlook) configuration
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21. (Optional) You can also add your voice messages mailbox as a favorite folder by performing
the following steps:

a. In Outlook, click the mail folder.

b. To expand the folder, click the plus sign (+).

c. Right-click Inbox, and then select Add to Favorite Folders.

Configuring Outlook 2007 for Avaya message store
Before you begin
Follow this procedure only if the Messaging store type (provided by your administrator) is Avaya
message store. This procedure is not applicable if the Messaging store type is Exchange server.

Procedure
1. Start Outlook.

2. On the Tools menu, click Account Settings....

You must create a default Outlook profile and load the default profile in Microsoft Office
Outlook 2007 otherwise, Outlook window closes automatically.

3. On the E-mail tab, click New.

The system displays the Choose E-mail Service dialog box.

4. Select the Microsoft Exchange, POP3, IMAP, or HTTP option, and then click Next.

The system displays the Auto Account Setup dialog box.

5. Select the Manually configure server settings or additional server types check box, and
then click Next.

The System displays the Choose E-mail Service dialog box.

6. Select the Internet E-mail option, and then click Next.

The System displays the Internet E-mail Settings dialog box.

7. In the Your Name box, type your name, for example Michael J. Smith.

8. In the E-mail Address box, type the email address that you use for your Avaya message
store.

9. In the Server Information section, select IMAP for Account Types.

10. In the Incoming mail server box, type the Messaging server address provided by your
administrator.

11. In the Outgoing mail server (SMTP) box, type the name of your Messaging server address
provided by your administrator. This is the same server as mentioned at the previous step.

Messaging from your e-mail client
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Note:

• The Outgoing mail server (SMTP) is to be used by Messaging only. Do not send e-
mails using this account. To send e-mails, use your designated email account.

• To reply to voice messages or to forward them, use the Messaging toolbar or right-
click on the voice message and click on the appropriate functions under Custom
Actions in the context-sensitive menu.

12. In the User Name box, type your assigned internal identifier.

For example, fName.lName.112233 @FQDNOFAAMStorageServer. You must use the entire
local part fName.lName.11223 till @ sign as user name for IMAP.

13. In the Password box, type your Messaging password.

14. Click More Settings….

15. On the General tab, replace the default name for the mail account with Avaya Aura
Messaging or a similar designation to indicate that this is your voice messages mailbox.

16. Select Auto for Use the following type of encrypted connection for both Incoming and
Outgoing servers in the Server Port Numbers section.

17. Click the Outgoing Server tab.

18. Select the My outgoing server (SMTP) requires authentication check box.

19. Select the Use same settings as my incoming mail server option.

20. Click OK.

21. Click Next when you finish entering this configuration information, and then click Finish.

22. (Optional) You can also add your voice messages mailbox as a favorite folder by performing
the following steps:

a. In Outlook, click the mail folder.
b. To expand the folder, click the plus sign (+).
c. Right-click Inbox, and then select Add to Favorite Folders.

Configuring Outlook 2003 for Avaya message store
Before you begin
Follow this procedure only if the Messaging store type (provided by your administrator) is Avaya
message store. This procedure is not applicable if the Messaging store type is Exchange server.

About this task
To configure Microsoft Office Outlook 2003 and earlier versions of Outlook, perform the following
steps:

Procedure
1. Start Outlook.
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2. On the Tools menu, click E-mail Accounts....

The system displays the E-mail Accounts dialog box.

3. Select the Add a new e-mail account check box under E-mail, and then click Next.

The system displays the Server Type dialog box.

4. Select IMAP as the type of account that you are creating, and then click Next.

The system displays the Internet E-mail Settings (IMAP) dialog box.

5. In the Your Name box, type your name, for example Michael J. Smith.

6. In the E-mail Address box, type the email address that you use for your Avaya message
store.

7. In the User Name box, type your internal identifier.

For example, fName.lName.112233 @FQDNOF AAMStorageServer. You must use the
entire local part fName.lName.11223 till @ sign as user name for IMAP.

8. In the Password box, type your Messaging mailbox password.

9. In the Incoming mail server box, type the Messaging server address provided by your
administrator.

10. In the Outgoing mail server (SMTP) box, type the name of your Messaging server address
provided by your administrator. This is the same server as mentioned in the previous step.

Note:

The Outgoing mail server (SMTP) is to be used by Messaging only. Do not send emails
using this account. To send emails, use your designated email account. To reply to voice
messages or to forward them, use the Messaging toolbar.

11. Click More Settings….

12. On the General tab, replace the default name for the mail account with Avaya Aura
Messaging or a similar designation to indicate that this is your voice messages mailbox and
click OK

13. Click Next when you finish entering this configuration information, and then click Finish.

14. (Optional) You can also add your voice messages mailbox as a favorite folder by performing
the following steps:

a. In Outlook, click the mail folder.
b. To expand the folder, click the plus sign (+).
c. Right-click Inbox, and then select Add to Favorite Folders.

Purging deleted messages
By default, Outlook does not automatically purge deleted messages. You might notice that when
you mark an item on an IMAP server for deletion, it is displayed in strike-through text. This can lead
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users to unexpectedly run out of space in their mailboxes. The manual steps for purging differ
slightly depending on the Outlook versions.

Before you begin
Ensure that you are working online and connected to the IMAP server.

About this task
You can either manually purge messages marked for deletion, or configure Outlook to delete any
marked items when you switch between folders.

Procedure
1. For Outlook 2010 and 2013, perform the following steps to purge deleted items:

a. Open the folder from which you want to purge deleted items.

b. On the main menu, click Folder.

c. Click Purge and select Purge Marked Items in Folder name.

2. To configure Outlook 2010 or 2013 to delete any marked items when you switch between
folders, perform the following steps:

a. On the main menu, select Folder > Purge > Purge Options.

b. For Outlook 2010, click Deleted Items tab and select Purge items when switching
folders while online.

c. For Outlook 2013, click Advanced tab and select Purge items when switching
folders while online.

d. Click Ok.

3. For Outlook 2007, perform the following steps to purge deleted items:

a. Open the folder from which you want to purge deleted items.

b. On the main menu, click Edit.

c. Click Purge and select Purge Marked Items in Folder name.

4. To configure Outlook 2007 to delete any marked items when you switch between folders,
perform the following steps:

a. On the main menu, select Edit > Purge > Purge Options.

b. Click General tab and select Purge items when switching folders while online.

c. Click Ok.

5. For Outlook 2003, perform the following steps to purge deleted items:

a. On the main menu, click Edit.

b. Click Purge Deleted Messages.
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Voice messages

MWI and message status
Voice messages appear as unread until they are accessed over the phone or are marked as read in
your email client. The message waiting indicator (MWI) light on your desk phone remains switched
on as long as one or more voice messages in your Messaging Inbox are marked as Unread. The
MWI light is turned off when all voice messages in your Inbox are marked as Read.

MWI behavior with the Aria TUI
• If you skip a message by pressing # before ten seconds of message playback has elapsed, the

message remains marked as Unread and the MWI lamp remains switched on.
• If you skip a message by pressing # after ten seconds of message playback has elapsed, the

message is marked as Read.
• From Messaging 6.1 Service Pack 1 onwards, if you save a message, it is marked as Read

even if the message played back for less than ten seconds.

MWI behavior with the Audix and CallPilot TUIs
• As soon as you start reviewing a message, it is marked as Read.

MWI behavior with Outlook
If Outlook is in cached mode when you delete a message, the MWI light switches off only after the
next synchronization between Outlook and Exchange. The MWI light is switched off when there is
any change in Outlook that influences the MWI, such as read or unread status change, deletion of a
message, or moving a message to another folder.

Private messages
If you need to protect your outgoing message from being forwarded by the recipient, mark it as
Private. When Avaya Message Store is the storage destination for Messaging:

• Recipients of a Private voice message can only access it from a phone.

• Private voice messages cannot be forwarded.

When Exchange is the storage destination, Private messages are flagged as private but otherwise
not protected.

Moved messages
Voice messages can be moved from your inbox to other folders like any other email. Once a
message is moved, it is no longer available over the phone.

Messaging from your e-mail client
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Auto Delete Notification and Message Retention
Using the Auto Delete Notification feature, you can set the TUI to play a warning if any messages
are near the automatic deletion date. You can use your TUI to review the soon-to-be-deleted
messages and restore the messages that you want to keep.

The administrator configures the Messaging threshold for the message retention capacity. The
administrator must set appropriate permissions for you to use the Message Retention feature.

Note:
The TUI plays auto delete notification only when one or more messages are pending for
deletion.

Non Delivery Report notification
You receive a Non Delivery Report (NDR) or Delivery Status Notification (DSN) when the system
exhausts all attempts to deliver a voice mail to the listed recipients. NDRs are not presented for
Exchange users. NDRs may not include the original message information and a recording of the
original message sent.

Auto Delete Notification and Message Retention
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Chapter 3: Fax

Using the fax feature of Messaging, you can perform the following :

• Receive faxes to a specified email address.

• Send faxes from any appropriately configured and supported version of Windows desktop.

Messaging administrators control which groups of users can send and receive faxes.

Related Links
Inbound fax on page 26
Outbound fax on page 27
Troubleshooting the fax issues on page 35

Inbound fax
The Messaging system receives inbound fax messages and forwards them to a specified email
address. You can receive fax messages to any the following email addresses depending on your
Messaging mailbox configuration:

• The email address specified in the internal corporate directory.

• The email address specified in the User Preferences webpage.

The maximum transmission length of an inbound fax is 90 minutes. After 90 minutes, Messaging
stops the transmission and sends a report to the sending fax server. The report includes the number
of pages transmitted successfully.

You cannot gain access to inbound faxes from the TUIs because Messaging does not store any
faxes in the message store. Message Waiting Indicator of the TUIs does not light up on receipt of a
new fax.

Cache for fax
The Messaging system only caches inbound faxes if you have a specified email address in User
Preferences. The system does not cache outbound faxes or inbound faxes sent to a fax server.

The default retention period for a cached fax is 72 hours. Messaging administrators can modify the
retention period.
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Outbound fax
Using Messaging, you can compose a document in a Windows-based program and fax it to any
destination fax number. The Messaging fax client on your desktop sends your document to the fax
printer service on the Avaya storage server. The fax printer service sends the document to the
application role, which sends it to the destination fax number.

You can change fax-related defaults in User Preferences.

Outbound fax has the following features:
• You can customize Transmitting Subscriber Identification (TSID) for outbound fax jobs. The

TSID is a string that identifies a specific fax machine as the sender of a fax transmission. By
default, the Messaging system assigns each user a TSID in the format mailbox@external
access number. You can change the default value of TSID through the General section of the
User Preferences webpage.

• You can configure email notifications for outbound fax. You can configure Messaging to send a
status notification by email for each fax that you send. You can enable the notification through
the Notify Me section of the User Preferences webpage.

• You can monitor the status of your outbound fax jobs. An outbound fax job is similar to a print
job. You can view and cancel your outbound fax jobs using the remote fax printer configured
on your Windows desktop. You can also delete failed fax jobs and remove them from the
queue.

Outbound fax has the following requirements:
• Messaging requirements. Your Messaging administrator must enable the fax support and

dialing privileges for your mailbox so that you can use the fax features.
• Computer requirements. Your computer must run either on the Windows XP or Windows 7

operating system. Your computer must support the Internet Printing Protocol (IPP) feature and
HTTP printing.

Messaging fax client pre-installation checklist
Get the administrator permission for the following Messaging fax client pre-installation tasks:

No. Task Description Notes

1 Configure the Internet
Printing Protocol (IPP)
feature

• See Turning on the IPP
feature on Windows 7 on
page 28

By default, your
computer has this
printing capability.
However, some
companies disable this
capability for security
reasons.

2 Configure the HyperText
Transfer Protocol (HTTP)
printing

• See Turning on the HTTP
printing on Windows XP and
Windows 7 on page 28

By default, your
computer has this
printing capability.
However, some

Outbound fax
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No. Task Description Notes

companies disable this
capability for security
reasons.

3 Download a fax client
installer

• See Downloading a fax client
installer on page 29

• See Supported languages for
the fax client installer on
page 29

4 Set the compatibility mode
on Windows 7

See Setting the compatibility
mode on Windows 7 on
page 30

IPP feature configuration
Turn on the IPP feature of your computer to enable secure remote printing. After enabling the IPP
feature, you can send messages to the Messaging fax client to print and generate fax messages.

By default, the IPP feature is enabled for the computers running on Windows XP. If not, contact your
system administrator.

Turning on the IPP feature on Windows 7
Before you begin
Get the administrator permission for enabling the IPP feature on computers running on Windows 7.

Procedure
1. Click Start  > Control Panel > Get programs > Turn Windows features on or off.

Windows displays the Windows Features window.

2. Expand Print and Document Services.

3. Select Internet Printing Client.

4. Click Ok.

HTTP printing configuration
Turn on the HTTP printing of your computer to send fax messages from your computer to the
network fax printer service on the Messaging storage server.

Turning on the HTTP printing on Windows XP and Windows 7
Before you begin
Get the administrator permission to enable the HTTP printing on your computer.

Procedure
1. Click Start  > Run.

Fax
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2. In the Open field, type regedit, and click OK.

3. Click HKEY_LOCAL_MACHINE  > SOFTWARE > Policies > Microsoft.

4. Click Windows NT > Printers.

5. Double-click DisableHTTPPrinting, and set the value to 0.

6. Click OK.

Downloading a fax client installer
About this task
Download the fax client installer from the Messaging storage server on your computer for a specific
language that you have set in the User Preferences webpage.

Important:
You must save the fax client installer on a local drive of your computer. You cannot install a fax
client from a shared location or a network drive.

Before you begin
Get the administrator permission for downloading the fax client installer.

Procedure
1. In Internet Explorer, type http://<Messaging storage server IP or AAM FQDN>/

download/<fax client installer>
where

• <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.

• <fax client installer> is the .msi file for a specific language that is required to install the fax
client for that language.

2. Press Enter.

3. (Optional) Click Continue to this website (not recommended).

The system displays a dialog box with the message: Do you want to run or save <fax
client installer> from <Messaging storage server IP or AAM FQDN>?

4. Click Save.

The system saves the fax client installer on your computer.

Supported languages for the fax client installer

Language Fax client installer file name
Arabic FaxClient_ar-SA.msi
Chinese-Peoples Republic of China FaxClient_zh-CN.msi
Chinese-Hong Kong FaxClient_zh-HK.msi
Dutch FaxClient_nl-NL.msi

Outbound fax
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Language Fax client installer file name
English-US FaxClient-en-US.msi
English-UK FaxClient_en-UK.msi
French FaxClient_fr-FR.msi
German FaxClient_de-DE.msi
Hebrew FaxClient_he-IL.msi
Italian FaxClient_it-IT.msi
Japanese FaxClient_ja-JP.msi
Korean FaxClient_ko-KR.msi
Polish FaxClient_pl-PL.msi
Portuguese-Brazilian FaxClient_pt-BR.msi
Russian FaxClient_ru-RU.msi
Spanish-Latin American FaxClient_es-XL.msi
Swedish FaxClient_sv-SE.msi
Turkish FaxClient_tr-TR.msi

Setting the compatibility mode on Windows 7
About this task
For computers running on Windows 7, you must set the compatibility mode to Windows XP or
earlier.

Before you begin
• Download the fax client installer for a specific language from the storage server on your

computer.
• Get the administrator permission to set your computer in the compatibility mode.

Procedure
1. Right-click the fax client installer, and click Properties.

2. In the Compatibility tab, select the following:

a. Run this program in compatibility mode for:

b. Previous version of Windows

3. Click OK.

Installing Messaging fax client
About this task
The Messaging fax client is a printer driver that prints your messages and generates fax messages.

Fax

30     Using Avaya Aura® Messaging R6.3 December 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Aura® Messaging R6.3


Before you begin
Complete the fax client pre-installation procedures.

Important:
If you do not complete the fax client pre-installation procedures and set the compatibility mode
on Windows 7, Messaging fax client fails to function.

Procedure
1. Run the fax client installer for your language.

2. Select I accept the terms in the License Agreement.

3. Click Install, and follow the instructions in the installation wizard.

4. Click Finish.

Messaging installs the fax client and adds Avaya Aura® Messaging Fax printer driver to the
list of Printers and Faxes.

5. Restart the computer.

Next steps
Configure the fax printer service to Windows.

Fax printer service configuration
The fax printer service is the remote fax printer on the Messaging storage server, where you send
fax messages. Add the fax printer service as a network printer on the Windows desktop to send
faxes to a destination number based on your dial-out privilege.

Adding the fax printer service as a network printer on Windows XP
Before you begin
Install the Messaging fax client on your computer.

Procedure
1. Click Start  > Settings  > Printers and Faxes > File  > Add Printer.

Windows displays the Add Printer Wizard window.

2. Click Next.

3. Select A network printer, or a printer attached to another computer, and click Next.

4. Select Connect to a printer on the Internet or on a home or office network:.

5. In the URL field, type http://<Messaging storage server IP or AAM FQDN>:
8631/printers/fax.

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.

Outbound fax
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6. Click Next.

Windows displays the Configure Internet Port window.

7. In the User Name field, type your mailbox number.

8. In the Password field, type your mailbox password.

9. Click OK, and follow the instructions of the Add Printer wizard.

10. Click Finish.

The system adds the following remote network printer to the Windows environment:

• fax on http://<Messaging storage server IP or AAM FQDN>:8631

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.

Adding the fax printer service as a network printer on Windows 7
Before you begin
Install the Messaging fax client on your computer.

Procedure
1. Click Start  > Devices and Printers > Add a printer.

Windows displays the Add Printer window.

2. Click Add a network, wireless or Bluetooth printer  > The printer that I want isn’t listed.

3. Select Select a shared printer by name.

4. In the search text box, type http://<Messaging storage server IP or AAM
FQDN>:8631/printers/fax.
where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.

5. Click Next.

Windows displays the Configure Internet Port window.

6. In the User Name field, type your mailbox number.

7. In the Password field, type your mailbox password.

8. Click OK, and follow the instructions of the Add Printer wizard.

9. Click Finish.

The system adds the following remote network printer to the Windows environment:

• fax on http://<Messaging storage server IP or AAM FQDN>:8631

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.
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Sending a fax
About this task
Using Messaging, you can send faxes to local, national, or international numbers depending on your
dial-out privileges. You can use any Windows-based program, such as Microsoft Word, to draft your
fax content. The fax client sends the drafted content without any cover page.

Before you begin
• Install the outbound fax client on your computer.
• Add the remote network printer to your environment.
• Request your administrator to configure the dial-out privileges for you to send a fax to a

destination number.
• When sending fax to a Messaging mailbox, ensure that the Messaging mailbox of the fax

receiver has fax privileges.

Procedure
1. Create a document in Windows with the content that you want to send as a fax message.

2. Click File  > Print.

3. From the list of printers, select Avaya Aura® Messaging Fax.

4. To confirm:

• For Windows XP, click OK.

• For Windows 7, click Print.

The system displays Avaya Aura® Messaging Fax Client.

5. In the Printer URL field, select http://<server name or IP>:8631/printers/fax
where

• http://<server name or IP>:8631/printers/fax is the remote fax printer that
you set up earlier. The system uses this printer to send the fax.

• <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.

6. In the Destination Fax field, type the fax number of the recipient.

If you are unsure of the format that you must use for an external fax number, contact your
administrator.

7. To preview your fax, select Display fax content.

8. Click OK.

If you enabled outbound fax notifications, the system sends you an email notification with the
status of each outbound fax job.

Outbound fax
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Managing outbound fax jobs
About this task
You can manage an outbound fax job as you manage the regular print jobs. You can cancel an in-
progress fax job or delete a failed fax job.

Procedure
1. Click Start.

2. To continue:

• For Windows XP, click Settings  > Printers and Faxes.

• For Windows 7, click Devices and Printers.

3. Double-click fax on http://<Messaging storage server IP or AAM FQDN>:8631

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.

4. Perform one of the following:

• To cancel a fax job that is in-progress, right-click the fax job and click Cancel.

• To delete a failed fax job, right-click the fax job and click Delete.

Changing your password in the network fax printer service
About this task
If you change your Messaging password, you must update the password in the network fax printer
service on the Messaging server. Otherwise, you cannot send faxes.

Procedure
1. Click Start.

2. To continue:

• For Windows XP, click Settings  > Printers and Faxes.

• For Windows 7, click Devices and Printers.

3. Click fax on http://<Messaging storage server IP or AAM FQDN>:8631

where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.

4. Set the server properties of the printer:

• For Windows XP, click File  > Server Properties  > Ports.

• For Windows 7, click Print server properties  > Ports.
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5. Select the port http://<Messaging storage server IP or AAM FQDN>:8631/
printers/fax
where <Messaging storage server IP or AAM FQDN> is the fully qualified domain name or IP
address of the Messaging server functioning as a storage server.

6. Click Configure Port.

Windows displays the Configure Internet Port window.

7. In the Password field, type your new mailbox password.

8. Click OK twice.

Troubleshooting the fax issues

Unable to download a fax client installer
Condition
Unable to download a fax client installer.

Solution
Recheck that you are using the correct URL to download the fax client installer.

Unable to add a fax printer service
Condition
When adding a fax printer service as a network printer on a Windows desktop, after typing the
username and password, Messaging displays the following error message:
They do not have access to the printer, please try a different username
or password.
Solution
Contact your system administrator.

Windows fails to connect to a fax printer service
Condition
Windows fails to connect to the added fax printer service.

Troubleshooting the fax issues
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Solution
Recheck that you enabled the IPP feature on your computer.

Unable to send a fax
Condition
Messaging displays the error message: Print file failed. rc = 1260.

Solution
Recheck that you enabled the HTTP printing feature on your computer.

A Messaging fax receiver is unable to receive faxes
Condition
A Messaging fax receiver is unable to receive faxes that you are sending.

Cause
The Messaging mailbox of the fax receiver does not have the fax privilege.

Solution
Ask the Messaging fax receiver to contact the administrator.

Unable to install the fax client installer on Windows 7
Condition
The Messaging fax client is not working as expected.

Cause
You did not follow the Messaging fax client pre-installation instructions and did not set the
compatibility mode on Windows 7.

Solution
1. Remove the Messaging fax client.
2. Follow the Messaging fax client pre-installation checklist, and recheck the configuration of

your computer.
3. Set the compatibility mode to Windows XP or earlier.
4. Reinstall the Messaging fax client.
5. Configure the fax printer service.

Fax
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Chapter 4: Customizing Messaging

About User Preferences
User Preferences is a web-based tool to customize settings for Messaging.

Note:

Some of these features may not be available in your organization. For details, contact your
administrator.

General preferences
The following User Preference features are found on the General Web page:

• Messaging Access Number

• Account Information

• Location and Language

• Mobile Phone or Pager

• Message Blocking Options

• Fax

• Play on Phone

• Attendant

Note:

Some of these features might not be available in your organization. For details, contact your
administrator.

Messaging access number
Messaging access numbers (internal and external) are used to access Messaging. Use the internal
number to dial from inside the office. The external number is the one that you dial from outside the
office. The internal and external Messaging access numbers are available on the User Preferences
> General page.
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If you see more than one Messaging access number (internal or external), use the number that is
assigned to a language that you know.

When you call the messaging access number from your mobile phone, Messaging recognizes your
mobile number. The Messaging system directly prompts you to enter your mailbox password,
skipping the need for you to enter your mailbox number. To ensure that the Messaging system
recognizes your mobile number, you must enter your mobile number in the correct format on the
User Preferences General page. To obtain the correct format of your mobile number, call your desk
phone and make note of the number as displayed on the caller ID.

Account Information
Account information displays the following fields:

• Mailbox: Displays your assigned voice messaging mailbox number.

• Extension: Displays your assigned phone extension.

• Auto logon: Displays the auto logon option for each extension. With the auto logon option, you
can log in to your mailbox using the extension on which you have enabled the auto logon
option without having to enter your mailbox number and password. Your administrator must
enable appropriate permissions for you to use the auto logon feature.

• Additional Extensions: Displays any additional phone extensions associated with your
mailbox. If the Additional extensions field is not displayed, no additional extensions are
configured for your mailbox.

Location and Language
Select your preferred time zone and language in the Location and Language section.

Time zone
Selecting a time zone affects the date and time announcement that the phone plays when you listen
to a voice message using the telephone user interface. Changes to the time zone also impact the
Reach Me Schedule on the Reach Me screen.

Language
You can select your preferred language that you want to use in the voice messaging system. If this
field is unavailable, the default language is available. This setting affects the following:

• The language of the voice prompts you hear when accessing your Messaging mailbox through
the telephone user interface.

• The language used for your User Preferences webpages.

You can configure a specific call answer language as the default call answer language with two
additional call answer languages. You must have appropriate permissions to define multiple call
answer languages.

Customizing Messaging
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Important:
You must not configure multiple languages when using One-Step Audix Recording feature, but
configure a single default call answer language.

Mobile Phone or Pager
You can use Mobile Phone or Pager for features such as:

• Notify Me (if enabled).

• Reach Me forwarding number.

• Other mobile phone when using Play on Phone, Voice Reply, Voice Forward, and Call
Sender in your email client.

For Mobile Phone or Pager: Select the Use this mobile phone or pager for "Notify Me" and
other features check box, and specify an alternate mobile phone or pager number to enable the
integrated login.

Note:

Avaya Aura® Messaging supports only email based (SMTP) pager notifications.

Message Blocking Options
With the Incoming Messages Blocking option, you can choose if you want Messaging to allow or
prevent your callers from leaving voice messages. The options available are:

• Never: Active by default. Incoming callers can record voice messages.
• Always: Incoming callers cannot record voice messages.
• Only when extended absence greeting is active: Incoming callers cannot record voice

messages if you have recorded and enabled an extended absence greeting.

On the basis of your selection, you can decide from the following options on how Messaging
processes the call:

• Disconnected: Messaging plays your greeting and disconnects the call.
• Transferred to a custom attendant (operator) : Messaging plays your greeting and transfers

the call to a custom attendant.

Your administrator must enable the appropriate permissions for you to use the income message
blocking feature.

General preferences
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Defining an email address for inbound fax
About this task
By default, you receive inbound fax messages at your email address specified in the internal
directory of your organization. However, you can define an email address of your choice for
receiving inbound fax messages from the General section of the User Preferences Web pages.

Procedure
1. In the Fax section, select the Forward incoming fax messages to: check box.

2. In the adjacent text box, type an email address.

3. Click Save.

Configuring TSID for outbound fax
Before you begin
Consult your system administrator before you change the TSID assigned to outbound faxes.

About this task
You can configure the transmitting subscriber identification (TSID) for outbound faxes with which fax
recipients identify the origin of an incoming fax. You can configure the TSID through the General
section of the User Preferences Web pages.

Procedure
1. In the Fax section, type a TSID of your choice in the Transmitting subscriber ID for

outgoing fax messages: field.

This field accepts a TSID of maximum length up to 128 characters. In case the field is left
blank, the field defaults to <Extension>@<External Messaging Access Number>.

2. Click Save.

Play On Phone
When you click Play on Phone, Voice Reply, Voice Forward, or Call Sender on the Messaging
toolbar, the system displays a pop-up window where you need to specify which phone is to be used
for the requested action. The Play on Phone settings on the User Preferences General page provide
options to manage this pop-up as follows:

• Always use this phone: Use this option to specify a phone number that you want to use for
Play on Phone, Voice Reply, Voice Forward, or Call Sender. This phone number will
automatically be used every time it is needed, and you will not be prompted with a pop-up for
this purpose.

Customizing Messaging
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• Ask me every time which phone to use: Use this option to restore the default setting where
the system displays a pop-up that prompts you to select a phone each time you use Play on
Phone, Voice Reply, Voice Forward, or Call Sender.

Attendant
Attendant settings define where calls are forwarded when a caller presses 0 while listening to your
voice message greeting.

The options available for Attendant are:

• Default attendant (operator) : Calls are routed to the system attendant (operator).

• Personal attendant/assistant: Calls are routed to another phone number. You must enter the
phone number, which can be internal (typically a phone extension) or external (any phone
number formatting is acceptable). If you do not see this field, your system administrator has
disabled this feature.

Reach Me preferences
Reach Me settings are located on the Reach Me Web page in your User Preferences. If you do not
have a Reach Me Web page, the Reach Me features have been disabled at the system
administration level.

The Reach Me feature provides callers with an opportunity to reach you on an alternate phone when
you do not answer or when your primary extension is busy. The Reach Me feature manages how
your incoming calls are forwarded based on the following:

• Caller priority - A priority status over other callers is given to the callers that you define as
priority callers.

• Call screening - You can screen the call before deciding to answer by asking the callers to
record their name.

• Forwarding numbers - For any incoming call, you can forward calls to up to three Reach Me
numbers.

• Schedule - You can forward calls during certain hours and on certain days defined by you.

Caller Categories
You can let the Reach Me feature handle all calls in an identical fashion, or define different call
handling actions for priority callers, internal callers, and external callers. You can configure a list of
priority callers through the User Preferences Web pages.

Reach Me preferences
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To define caller categories:

1. Navigate to the User Preferences > Reach Me page.

2. Under the Caller Categories section

• Select Treat all callers the same if you want to set the same call handling action for all
callers.

• Select Distinguish between internal callers and other callers to setup different call
handling actions for internal callers and other callers.

3. Click Save.

Call Handling
Call Handling settings are where:

• Reach Me is enabled, allowing you to forward your incoming calls.

Configuring incoming call handling when treating all callers the same
About this task
Call handling options depend on how you choose to categorize your callers. You can choose to treat
all callers the same in the manner:

Procedure
1. To configure Reach Me, select from the following options:

• To enable Reach me, select Forward calls to the Reach Me numbers below.

• To disable Reach Me, select Go to voice messaging.

2. When Reach Me is enabled, you can use call screening. To enable call screening, select the
Before forwarding, ask callers to record their name so I can screen the call check box.

3. Click Save.

Configuring incoming call handling with other callers
About this task
Options for Call Handling differ depending on how you chose to categorize your users. If you chose
to distinguish between internal callers and other callers, the system presents you with options to
define call handling for internal callers and other callers separately.

Procedure
1. To configure Reach Me for internal callers, select from the following options:

• To enable Reach Me, select Forward calls to the Reach Me numbers below .

• To disable Reach me, select Go to voice messaging.

Customizing Messaging
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2. To configure Reach Me for other callers, select from the following options:

• To enable Reach Me, select Forward calls to the Reach Me numbers below .

• To disable Reach me, select Go to voice messaging.

3. If you want to activate call screening, select the Before forwarding, ask callers to record
their name so I can screen the call check box.

4. Click Save.

Call screening
Call Screening is an optional Reach Me feature, which you can enable from the Call Handling
section of the Reach Me Web page in your User Preferences. When you enable call screening:

• Messaging prompts callers to record their names before forwarding the call to you.

• Messaging plays the recorded name when you receive the forwarded call on the basis of which
you can accept or reject the call.

If you reject the call, Messaging informs the caller that you are unavailable and routes the call to
your Messaging mailbox.

Defining your Reach Me numbers
Before you begin
These settings are applicable only when Reach Me is enabled.

About this task
With Reach Me enabled, incoming calls can be forwarded to up to three numbers. The Messaging
system tries to reach you at all your Reach Me numbers, by dialing them one at a time, before
forwarding a call to your Messaging mailbox.

To define Reach Me numbers:

Procedure
1. From the drop-down boxes, select the forwarding numbers.

2. For each Reach Me Number, specify a ring threshold. For most phones, 3 rings is a good
choice.

Defining a Reach Me schedule
Before you begin
These settings are applicable only when Reach Me is enabled.

Reach Me preferences
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About this task
When you enable Reach Me, you can set up a Reach Me schedule to forward calls during a certain
time period and for specific days of the week. By default, calls are forwarded between 9:00 AM and
5:00 PM, Monday through Friday.

To set up a Reach Me schedule:

Procedure
1. Select Forward calls only between.

2. Select a start and stop time.

3. Select the days that you would like the schedule to be in effect.

The system does not forward calls outside the schedule. If your extension rings and you do
not answer, the call is routed to your mailbox.

Reach Me default settings when re-enabled using the TUI
You can enable or disable Reach Me from the Aria or Audix TUI or by using the User Preferences
Web pages. If you use the TUI to re-enable Reach Me, the system:

• Enables call forwarding to previously defined Reach Me numbers.

• Enables the 'Treat all callers the same' option.

• Disables call screening.

• Enables Reach Me scheduling.

Testing your Reach Me configuration
After you configure your Reach Me settings, call your extension from a separate phone to
experience exactly what your callers experience. This is important for testing defined ring thresholds
and forwarding settings.

You have successfully configured your Reach Me settings if your test call is forwarded to all
specified phone numbers, one by one and then finally, to your Messaging mailbox.

Notify Me preferences
Notify Me settings are located on the Notify Me Web page in your User Preferences.

The Notify Me feature sends you a notification when you receive a new voice message. You receive
the notification by:

• Text message to your mobile phone.

Customizing Messaging
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• Phone call to your mobile phone.

• Page notification to your pager.

• Email notification to your email address.

You can also configure the Notify Me settings to send an email notification to your email address
after each successful outbound fax.

Notify Me settings offer the following rule-based configuration options, which are designed around
your availability:

• Disable when Extended Absence Greeting is active.

Note:

• If you do not have a Notify Me Web page, notification features have been disabled at the
system administration level. Similarly, if one of the described notification options is not
available, it has been disabled by the administrator.

• Avaya Aura® Messaging supports only email based (SMTP) pager notifications.

Configuring phone notifications
Before you begin
To enable text message or page notifications you must define a mobile phone or pager number. To
set up your mobile phone or pager number, specify the phone number in the Mobile Phone or Pager
section in General preferences. Avaya Aura® Messaging supports only email based (SMTP) pager
notifications.

About this task
To configure phone notifications, perform the following steps on the Notify Me Web page of your
User Preferences:

Procedure
1. On the Notify Me Web page of User Preferences, under Phone Notifications select Notify

me when a new voice message arrives.

2. Select one of the following notification options:

a. To receive notifications through a phone call, select With a phone call to:

The system displays the phone number you specified in the Other mobile phone or
pager field on the General Web page.

b. To receive notifications as text message or pager notifications, select With a text
message or page to:

The system displays the phone number you specified in the Other mobile phone or
pager field on the General Web page.

Notify Me preferences
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If you choose this option, you must select your service provider from the Mobile
provider drop-down list. Contact your system administrator if the system does not
display your mobile provider in the drop-down list.

c. Select Only for important messages if you want to receive notifications for voice
messages that the caller specifies as important in the respective TUI.

The Aria TUI provides two additional delivery options wherein the caller can mark the
voice messages as private and for future delivery.

Note:

In future delivery, you can set a future date on which you want the system to deliver
your voice message. In case you specify a delivery date without year and the
specified date is less than the current date, the system does not prompt any error
but delivers the voice message on the specified date next year.

3. Click Save.

Configuring email notification
You can receive an email notification of a new voice message to a specified email account. For
email notifications, the Messaging toolbar is not available. You might have to wait about 10 minutes
for your changes to take effect.

Procedure
1. On the Notify Me Web page of User Preferences, under Voice Email Notifications, select

the Email me a notification for each voice message check box.

2. Select Custom subject to customize the subject line of your email notifications. You can
enter up to 80 alphanumeric characters.

You can turn off custom subject lines later by selecting Default subject. The default format
for the subject line is: Voice message from <name or telephone number>.

3. In the To email addresses text box, enter the email address to which email notifications
need to be sent.

You can enter up to five email addresses. Use a semicolon to separate addresses.

4. Select the Include the recording check box if you want to include the recording of the voice
message. For Private messages, the voice message recording may not be included even if
this check box is selected, depending on the system configuration.

5. Select Only for important messages if you want to receive notifications for voice messages
that the caller specifies as important in the TUI.

Customizing Messaging
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Configuring fax email notifications
Before you begin
The administrator must enable the appropriate permissions for you to be able to use fax-related
features.

About this task
You can configure the system to send an email status notification for each outbound fax through the
Notify Me section of the User Preferences Web pages.

Procedure
1. In the Fax Email Notifications section, select the Email me a notification for each fax

message sent check box.

2. In the To email address field, type an email address to which you want the notifications to
be sent.

3. Click Save.

My Phone preferences
User preferences on the My Phone Web page allows you to customize your preferences when using
the telephone user interface.

The following user preference features are found on the My Phone Web page:

• Auto play

• Message Playback Order

• Message Playback Speed

• Prompt Level

• Date and Time Announcement

• Voice Recognition for Addressing Preferences

Note:

If one of the described phone preference features is not available on the My Phone Web page, it
has been disabled by the administrator.

My Phone preferences
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Auto play
The My Phone webpage only displays the auto play option if you use the CallPilot TUI. If you select
this option:

• The TUI automatically begins playback of messages upon log in. You do not have to press any
keys to initiate listening to messages.

• You define the message playback order on the My Phone webpage.

Message playback order options
You can set the order of the messages in which the TUI plays the messages to you. By default, the
TUI plays the messages starting with the newest message first. You can set the following playback
order options independently for unread, read, and saved messages:

• Play newest first to hear messages starting with the newest message first.

• Play oldest first to hear messages starting with the oldest message first.

• Play important messages before others to hear urgent messages first.

• Arrange by sender to hear messages that Messaging sorts by sender name.

Note:

- The My Phone page displays Arrange by sender option only if your administrator
activates the option for you.

- When you select Arrange by sender option, Messaging sorts in the normal sequence
unless your mailbox has multiple messages from the same sender.

- If the envelope information for the message does not include the name of the sender,
Messaging uses the telephone number of the sender.

Some of the message playback options might not be available for your TUI.

Changing message playback speed
About this task
When reviewing messages using the phone, by default, they are initially played at normal speed, or
100%. Telephone keypad options are available to speed up or slow down the message during
review. By setting the Message Playback Speed, you can choose a slower or faster default speed at
which all messages are initially played. After setting a slower or faster default playback speed, the
telephone keypad options are still available to further speed up or slow down an individual message
during review.
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Procedure
1. To hear messages at a slower than normal speed, choose one of the following (in order of

slowest to fastest):

• 70%

• 85%

• 90%

2. To hear messages at a faster than normal speed, choose one of the following (in order of
slowest to fastest):

• 125%

• 170%

3. To return to normal speed, select 100%.

Enabling Rapid Prompts

About this task
Rapid prompts are a set of short, condensed phone prompts that replace the standard phone
prompts. Because they are much shorter, rapid prompts help you save time. For example, for the
standard prompt 'Message sent. Only your introduction will be heard before the original message',
the corresponding rapid prompt is 'Sent'.

Use rapid prompts only if you are familiar with the standard prompts and do not need to hear
instructions in detail each time you use Messaging. If you cannot see the Use Rapid Prompts
check box on the My Phone page in User Preferences, your administrator has not setup rapid
prompts on the Messaging system or you have not selected a language that supports rapid prompts
on the General page in User Preferences.

Rapid prompts are currently only available in US English for the Aria TUI .

To enable rapid prompts on your phone:

Procedure
1. Enable the Use Rapid Prompts check box on the My Phone page in User Preferences.

Setting date and time announcement
Procedure
1. Select Announce date and time for each message to hear the date and time that a message
was received before reviewing it from the telephone user interface.

My Phone preferences
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Setting addressing preferences
About this task
Messaging provides the following options to select recipients for a message:

1. Voice recognition: You can use Voice recognition to select recipients or distribution lists by
speaking their full name (as listed in the internal directory or as defined by you for your
personal lists).

2. Telephone keypad: You can use the telephone keypad to select recipients or distribution list
by using the keypad to spell their name or enter their mailbox number.

Procedure
1. To set your addressing preferences, select one of the following options:

• Select Using voice or keypad to use both voice recognition and the telephone keypad to select
voice message recipients.

• Select Using keypad only to use only the telephone keypad to select voice message recipients.

Note:

Some of these features may not be available in your organization. For details, contact your
administrator.

Personal lists
When you want to send a voice message to many voice messaging recipients, you can create one
or more personal distribution lists in the Personal Lists page of your User Preferences Web page.

Creating a personal list
Procedure

1. In the User Preferences Web page, click Personal Lists.

2. In the Personal Lists Web page, click Add New List.

3. In the List name text box, specify a name for your personal list. You can use this name
when addressing an outgoing message.

4. From the List number drop-down list, select a list number. The list number ranges from 11
to 99.

5. In the New member (mail box) text box, enter the mailbox number of the member that you
want to add to your personal list, and then click Add.

The system displays the First Name, Last Name, and Mailbox of the newly added member.
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6. Continue adding members until you have all the names you would like to include in your
personal list. The maximum number of members that you can add in a personal list is 100.

7. Click Save.

The maximum number of personal lists that you can create is 89.

Editing a personal list
Procedure

1. From the Personal list: drop-down list, select the personal list that you want to edit.

2. Click Edit.

3. You can perform the following actions:

• Edit the list name
• Change the list number
• Delete existing members
• Add new members

Editing the list name
Procedure

1. In the List name: text box, type the new name of the list.

2. Click Save.

Changing the list number
Procedure

1. From the List number: drop-down list, select an available new list number for your personal
list.

2. Click Save.

Deleting existing members
Procedure

1. In the Members: list, identify the member you want to delete, and then click Delete.

2. Continue deleting members until you have deleted all the members you would like to remove
from your personal list.

3. Click Save.

Adding new members
Procedure

1. In the New member (mailbox): text box, enter the mailbox number of the member you
would like to add to your existing personal list.

Personal lists
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2. Continue adding members until you have added all the members you would like to have in
your personal list.

3. Click Save.

Deleting a personal list
Procedure

1. From the Personal list drop-down list, select the personal list that you want to delete.

2. Click Delete.

3. Click OK to confirm.

Enhanced lists
Using the Enhanced List page, you can add or delete members of enhanced lists defined by the
system administrator.

Note:

You can only see the Enhanced List User Preferences Web page if the system administrator
added you to the administrator list for at least one enhanced list.

Editing an enhanced list
Procedure

1. In the User Preferences Web page, click Enhanced Lists.

2. From the Enhanced list: drop-down list, select the enhanced list that you want to edit.

3. Click Edit.

4. You can perform the following actions:

• Delete existing members

• Add new members

Deleting existing members
Procedure

1. In the Members: list, identify the member you want to delete, and then click Delete.

2. Continue deleting members until you have deleted all the members you would like to remove
from your enhanced list.

3. Click Save.
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Adding new members
Procedure

1. In the New member: text box, enter the mailbox number or email address of the member
you would like to add to your existing enhanced list.

2. Continue adding members until you have added all the members you would like to have in
your enhanced list.

3. Click Save.

Greetings
Greetings include prerecorded names and messages that the TUIs play to the callers when a call
reaches your voice mail. If you do not want the TUIs to play the default Messaging system
greetings, you can customize the following:

• Names: You can record your name to replace the system-generated version of your name.

• Standard Greetings: You can record the following standard greetings for the phone to play to
the callers:

- Personal Greeting: To reply to callers when you cannot answer a call. For example, when
you are away or when your line is busy.

- Extended Absence Greeting (EAG): To inform callers of the reason for not responding to the
calls immediately. For example, when you are away from the office .

• Optional Greetings: You can record optional greetings that the phone plays based on a set of
optional rules. For example, you can set up an optional greeting to play during office hours to
all internal callers who get no answer on your phone.

Important:

You can set either the Standard Greetings or the Optional Greetings for the TUI to play.

You can record only voice messages. Messaging does not support recording music as
greetings.

To configure your greetings from a TUI, see one of the following documents at the Messaging User
Guides Section at the Avaya Support website:

• Avaya Aura® Messaging Aria Quick Reference

• Avaya Aura® Messaging Audix Quick Reference

• Avaya Aura® Messaging CallPilot Quick Reference

If you do not know which TUI you use, contact your administrator.

Greetings
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Recording your name
Procedure

1. Log in to User Preferences and navigate to the Greetings page.

2. Click the Record icon in the Recorded Name row.

3. Use the controls in the Recording: Recorded Name section to record, play, and save your
name.

Configuring standard greetings
You can configure settings for your standard greetings from the Greetings tab on the User
Preferences Web pages. Your administrator must enable appropriate permissions for you to use
standard greetings-related features.

Procedure
1. To record your Personal greeting, click the appropriate Record icon on the personal greeting

row.

• Red Record icon: Click to record greeting from your computer. A separate section
Recording: Personal opens on the User Preferences Greetings webpage, to record,
play, rerecord, pause, stop, and save the recorded greeting.

• Green Record icon: Click to record greeting from phone. A separate window opens,
directing you to your phone number associated with the Messaging application.

Once you save a recorded greeting, you can click the Play icon to play the greeting.

• Arrow Play icon: Click to play a recorded greeting on your computer.

• Phone Play icon: Click to play a recorded greeting on your phone. Directs you to the
phone number associated with the Messaging application.

2. To activate your Personal greeting, select the Active check box on the personal greeting
row.

3. To activate your Extended Absence greeting, select the Active check box on the extended
absence greeting row.

• Red Record icon: Click to record greeting from your computer. A separate section
Recording: Extended Absence appears on the User Preferences Greetings web page,
allowing you to record, play, rerecord, pause, stop, and save the recorded greeting.

• Green Record icon: Click to record greeting from phone. A separate window opens,
directing you to your phone number associated with the Messaging application.

Once you save a recorded greeting, you can click the Play icon to play the greeting.

• Arrow Play icon: Click to play a recorded greeting on your computer.
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• Phone Play icon: Click to play a recorded greeting on your phone. Directs you to the
phone number associated with the Messaging application.

4. If you want a greeting to expire within a certain time limit, select the Enable Expiry check
box, and set the Expiration Date/Time for that greeting.

5. <Optional> If you want Messaging to play your current status before playing the standard
greeting, select the Play status prompt before greeting check box.

6. Click Save.

Configuring optional greetings
You can configure your optional greetings from the Greetings tab on the User Preferences Web
pages. You can also configure greeting rules, based on which Messaging plays optional greetings to
your callers. The rules are designed on the basis of your availability. Your administrator must enable
appropriate permissions for you to use optional greetings-related features.

Procedure
1. To record Optional Greetings, click the appropriate Record icon on each optional greeting

row.

• Red Record icon: Click to record greeting from your computer. A separate section
Recording: Optional Greeting number opens on the User Preferences Greetings
webpage, to record, play, rerecord, pause, stop, and save the recorded greeting.

• Green Record icon: Click to record greeting from phone. A separate window opens,
directing you to your phone number associated with the Messaging application.

Once you save a recorded greeting, you can click the Play icon to play the greeting.

• Arrow Play icon: Click to play a recorded greeting on your computer.

• Phone Play icon: Click to play a recorded greeting on your phone. Directs you to the
phone number associated with the Messaging application.

2. Activate an optional greeting of your choice by selecting the Active check box for that
greeting.

3. Enter a description for the selected greeting in the Description field.

4. Select a call type from the All / Internal / External drop-down list box.

• To set the optional greeting to play for all calls, select All.

• To set the optional greeting to play for internal calls only, select Internal. Messaging
classifies only the systemwide set of users or the mailboxes on the system as internal
callers. In that case, the TUI plays the recorded internal greeting to the internal callers.

• To set the optional greeting to play for external calls only, select External. Messaging
classifies a caller as an external caller, if the caller does not have a mailbox on the
system. In that case, the TUI plays the recorded external greeting to the external callers.

Greetings
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5. Select a phone status from the All / Busy / No Answer drop-down list box.

• To set the optional greeting to play for all calls, select All.

• To set the optional greeting to play only when your phone is busy, select Busy.

• To set the optional greeting to play only when a caller gets no answer on your phone,
select No Answer.

6. Select a time zone from the All / Office Hours / Non Office Hours drop-down list box. The
office hours are defined in the Business Hours section.

• To set the optional greeting to play at all times, select All.

• To set the optional greeting to play only during office hours, select Office Hours.

• To set the optional greeting to play only during non office hours, select Non Office Hours.

7. Click Save.

Defining business hours
Before you begin
These settings are applicable only when greetings are enabled.

About this task
You can customize your business hours and set up the time period on each day, for specific days of
the week. By default, business hours are between 8:00 AM and 6:00 PM, Monday through Friday.

Procedure
1. On the Greetings tab, set the start and end times for the Business Hours Between fields.

2. Define the days of your work week, by individually selecting the check box adjacent to each
day of the week.

Changing your password

From a phone
About this task
To change your password from a phone, refer to one of the following documents:

• The Quick Reference Guide for Avaya Aura® Messaging (Aria)
• The Quick Reference Guide for Avaya Aura® Messaging (Audix)
• The Quick Reference Guide for Avaya Aura® Messaging (CallPilot)
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These guides are available at the Messaging User Guides Section at the Avaya Support Web site. If
you do not know which TUI you use, contact your administrator.

From User Preferences
About this task
To change the password using User Preferences, perform the following steps:

Procedure
1. On the User Preferences Web page, click Password.

2. Enter a new password, and confirm it.

3. Click Change.

Advanced tasks

Clearing the mailbox number association
About this task
From the Advanced User Preferences screen, you can reset the association between your
Messaging mailbox and your email identity.

Note:
Do not to perform this task, unless instructed by your Administrator or an Avaya Services
Technician.

Procedure
1. Log in to the User Preferences Web page.

2. From the menu on the left, click Advanced.

3. On the Advanced Tasks screen, click Clear.

Broadcasting a message
Before you begin
Your administrator must enable the broadcasting feature on your user account.

Advanced tasks
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About this task
You can broadcast a system-level or site-level message to your organization through your TUI.
Messaging can store a maximum of only one system-level message and one site-level message for
each site configured on the system. Recipients of a broadcast message can access at most two
recent broadcast messages at any given time. If another broadcast message is received, the system
overwrites the existing message. The system plays the broadcast messages in the following order.

• System broadcast
• Site broadcast

Procedure
1. From the main menu, perform one of the following depending on your TUI:

• Aria or Audix TUI: Press 9 to access the broadcast menu.

• CallPilot TUI: Press 5 to access the broadcast menu.

2. To record a new broadcast message, press 2.

3. Depending on your TUI, perform one of the following:

• Aria TUI: Press # to stop recording and press # to send the message.

• Audix TUI: Press # to stop recording and send the message. You can press 1 to stop
recording and review the message.

• CallPilot TUI: Press # to stop recording and press 7–9 to send the message.
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Chapter 5: Messaging with a Teletypewriter

Teletypewriter overview
A teletypewriter (TTY) is a data terminal that people who are hearing impaired or speech impaired
can use to transmit and receive text through a telephone system. A TTY is also referred to as
Telecommunications Device for the Deaf, or TDD. A typical TTY resembles the keyboard of a laptop
computer with a one-line or a two-line alphanumeric display. The TTY is silent when it is not used to
transmit text. As a user types on the device, the TTY emits audio tones that the telephone network
transmits.

Not all TTY users transmit and receive messages with TTY devices. Approximately half of the
people who rely on TTY devices are hearing impaired, but can speak clearly. They often prefer to
receive messages on their TTY devices and then speak in response. This process is referred to as
Voice Carry Over, or VCO.

Messaging only supports the Audix TUI with the TTY devices. Also, Messaging does not provide
automatic TTY support in Messaging mailboxes. Administrators need to enable TTY support. In
Messaging, administrators can configure mailboxes so that callers can select TTY-format, or voice
prompting from the same mailbox.

Messaging teletypewriter user interface
In Messaging, the administrator installs the US English TTY language pack to provide the TTY
support. The TTY prompts make most Messaging features available to users of TTY devices.
Messaging users can send, receive, and respond to TTY messages with a TTY device. Users press
the same telephone keys to send, receive, and respond to TTY messages and voice messages.

Users whose mailboxes are set up for TTY can:

• Use the TTY language for most Messaging menus, prompts, and messages.

• Use Messaging to answer incoming telephone calls with a TTY greeting.

Callers can use the Messaging TTY or voice prompts when they record messages.

Messaging also supports the use of TTY and voice during the same call. For example, during a
VCO session, a user can receive a prompt in TTY format and then record a voice message. Hearing
impaired people who speak clearly can receive messages with a TTY device and send a voice
message during the same call.
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Important information for TTY users
Recommended hardware
Ensure that you use push-button or touchtone dialing during your call to make menu selections or
enter data. Many TTY devices, including the Avaya Model 8840 TTY, can generate touchtones to
dial a number. However, after the call is connected, these devices switch automatically from
touchtone mode to TTY mode. For this reason, you need to use a separate touchtone telephone
with the TTY device. One way to do this is to use an acoustic coupler to connect the TTY device and
the telephone.

An alternative approach is to use the TTY with an Avaya IP Softphone. Configure the IP Softphone
to be in Telecommuter mode and designate the TTY device as the associated analog telephone.
The IP Softphone user interface allows touchtones to be transmitted to Messaging.

For more information on configuring the IP Softphone to be in Telecommuter mode, refer to the
guide Using Avaya one-X® Communicator, topic name: Configuring outgoing call settings.

Messaging prompts
When you use Messaging with a TTY device, the system displays menus and prompts on the TTY
device. The menus and prompts present options for Messaging features. Frequently, you get
Messaging prompts to press numbers or type letters and characters on the telephone keypad. When
you press the keys on the telephone keypad in response to the prompts, you send commands in the
form of touchtone signals to Messaging. The only time that you type on the TTY device is after you
receive the Go Ahead (GA) prompt.

Teletypewriter tones to text conversion
When you receive a voice message, the TTY device either displays no text, or occasional random
characters. When a message contains voice, the signal indicator on the TTY device fluctuates
randomly. The TTY device converts the TTY tones to text on the TTY device display, but cannot
similarly convert audio voice messages to text. If necessary, request assistance from another
person, such as a relay operator.

Messaging and Teletypewriter signaling
Two Messaging TUI options interfere with the signaling between Messaging and TTY devices. TTY
device users cannot use TUI features that:

• Adjust the playback speed of a voice message.

• Skip forward or backward within a message while the message is playing.

For example, if you change the playback rate of a Messaging TTY message, you also change the
baud rate of the transmission. Messaging and the receiving TTY device are no longer synchronized.

Note:

These TUI features might not be available for your TUI.
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For more information about TTY related troubleshooting, see Typographical errors and missing
characters in messages on page 67.

Log in to Messaging
You can log in to Messaging in two ways:

Option 1: Dialing your extension
If TTY is used as one of the default languages for your organization, then Messaging sends all
prompts and messages in TTY format.

For more information, see Dialing your extension on page 61.

Option 2: Dialing Messaging
When Messaging answers your call, you receive instructions with prompts spoken in the default
language for your organization. In this case, you need to select the TTY language option before you
can proceed. If your organization has a separate number that sends prompts in TTY only, use that
number to access Messaging.

Dialing your extension
About this task
Use the following procedure to use a TTY device directly:

Procedure
1. Dial your telephone number.

2. If the extension does not have an associated mailbox and TTY is not the Site default
language for this Messaging number, and there are additional languages available:

a. If TTY is configured as first additional language, press 2. Messaging prompts “TO SEE
ENGLISH TTY DIAL TWO”.

b. If TTY is configured as second additional language, press 3. Messaging prompts “TO
SEE ENGLISH TTY DIAL THREE”.

If TTY is not selected, Messaging plays a spoken message.

Note:

The signal indicator light on the TTY device flickers to indicate that Messaging answered
the call. Look at the signal indicator to determine whether Messaging answered the call.
If you cannot determine that Messaging answered the call, wait 10 seconds after you
dial and continue.

Log in to Messaging
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3. If you are placing the call from your office extension, you receive a Messaging prompt to
enter your password in TTY. Dial your password, and press the pound key (#).

4. If you are calling from another extension or from outside your organization, use one of the
following telephone key combinations:

• If the extension does not have an associated mailbox, press the pound key (#).

- Dial your mailbox number.

- Dial your password. After that, Messaging switches to your selected language and
prompts you to enter the password.

- Press the pound key (#).

• If the extension has an associated mailbox, you receive a Messaging prompt to enter your
password in TTY. Dial your password, and press the pound key (#).

Result
You are now logged in to your mailbox. The TTY device displays your name and informs you if have
any new messages. The TTY device displays a menu of options.

Next steps
To choose an option, press the appropriate telephone key.

Dialing Messaging
About this task
Use the following procedure to dial in to Messaging, and then use the TTY device.

Procedure
1. Dial the telephone number of the Messaging system.

2. If the extension does not have an associated mailbox and TTY is not the Site default
language for this Messaging number, and there are additional languages available:

a. If TTY is configured as first additional language, press 2. Messaging prompts “TO SEE
ENGLISH TTY DIAL TWO”.

b. If TTY is configured as second additional language, press 3. Messaging prompts “TO
SEE ENGLISH TTY DIAL THREE”.

If TTY is not selected, Messaging plays a spoken message.

Note:

The signal indicator light on the TTY device flickers to indicate that Messaging answered
the call. Look at the signal indicator to determine whether Messaging answered the call.
If you cannot determine that Messaging answered the call, wait 10 seconds after you
dial and continue.
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3. If you are placing the call from your office extension, you receive a Messaging prompt to
enter your password in TTY. Dial your password, and press the pound key (#).

4. If you are calling from another extension or from outside your organization, use one of the
following telephone key combinations:

• If the extension does not have an associated mailbox, press the pound key (#).

- Dial your mailbox number.

- Dial your password. After that, Messaging switches to your selected language and
prompts you to enter the password.

- Press the pound key (#).

• If the extension has an associated mailbox, you receive a Messaging prompt to enter your
password in TTY. Dial your password, and press the pound key (#).

Result
Your extension and password identify you as a valid user.

You are now logged in to your mailbox. The TTY device displays your name and whether you have
new messages. The TTY device displays a menu of options.

Next steps
To choose an option, press the appropriate telephone key.

Using the Messaging teletypewriter user interface

Recording your name
About this task
The Messaging system stores your name in your mailbox. To change your name, follow the TTY
prompts for your TUI. When Messaging prompts you to record your name, use your TTY device to
type your name. Ensure that you wait for the GA prompt before you start to type.

Note:
To ensure that the text you type displays correctly when played back, do the following on your
TTY device before you type your name:

Procedure
1. Log in to Messaging using your TTY device.

2. Press 5 twice to navigate to the Record Name menu.

3. Type a single digit or a forward slash (/).

4. Press Spacebar on your TTY device a few times.

Using the Messaging teletypewriter user interface
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Recording and sending messages
About this task
The TUI that you use determines how you record and send messages.

Procedure
1. Log in to Messaging using your TTY device.

2. Press the appropriate telephone key to record a message.

3. When the TTY device displays the GA prompt, type your message, and then press the
pound key (#).

4. Dial the mailbox number of the person to whom you want to send the message.

5. Press the pound key (#).

The TTY device displays the name of the person.

• If the TTY device display is blank, the name was not recorded for Messaging using a TTY
device. If the mailbox number is correct, continue with Step 6.

• If the TTY device displays an incorrect name, you might have dialed the wrong mailbox
number. Press the appropriate telephone key to delete the address, and repeat Step 4.

6. Press the pound key (#) to end the addressing.

7. Press the appropriate telephone key combination for your TUI to send the message.
Depending on your TUI, you can send a message in the following ways:

• Immediately or later.

• As a private or a normal message.

• As a high-priority or a standard priority message.

8. The system transmits your message and returns you to the main menu.

Getting and responding to messages
About this task
The TUI you use determines how you get messages.

Procedure
1. Log in to Messaging.

2. Press the appropriate telephone key to get and respond to the messages that people sent
you.
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3. Messaging proceeds with the first new message and provides prompts for actions that you
can perform. Depending on your TUI, you can send or forward messages by using the
following methods:

• Call the sender.

• Reply to the message.

• Forward the message with a comment.

• Reply to all recipients.

• Send a message now or later.

• Send the message as a private message.

• Send the message as a priority message.

• Delete the message.

• Save the message.

• Skip to the next message.

The TTY device displays the next message in your mailbox.

4. Repeat step 3 for each new message in your mailbox.

When there are no more new messages, Messaging returns you to the main menu.

Administer greetings
When you do not answer a call, the call is transferred to voicemail and Messaging plays the greeting
that you recorded.

Ensure that your personal greeting contains both voice and TTY portions.

• Voice portion: You can record a brief voice message to tell callers that they reached a TTY
mailbox. Tell callers that they can press 1 to leave a voice message.

• TTY portion: While recording the voice portion, add a TTY recording to the greeting. In the
greeting, tell TTY callers to leave a TTY message after they receive the GA prompt.

You do not need to record a personalized greeting. If you choose not to record a personalized
greeting, the system plays a predefined greeting.

If your active Call Answer language is TTY, Messaging displays the TTY prompt “Leave a message
for <number>.”

If the caller selects a spoken language, Messaging plays the spoken prompt “Please leave a voice
message for <name>.”

The TUI you use determines how you administer greetings.
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Recording a combined spoken and TTY greeting
About this task
To record a combined spoken and TTY greeting for your primary greeting:

Procedure
1. Log in to Messaging.

2. Press the appropriate telephone key to select the Personal Configuration or greetings menu.

3. Press the appropriate telephone key to record the personal greeting.

4. When Messaging displays the GA prompt on the TTY device, use the telephone handset to
record the brief spoken portion of your greeting.

Important:

Keep the spoken portion of your greeting brief, so that TTY callers do not think that they
have reached the wrong number.

The following message is an example of what you can record:

“This is the TTY mailbox for John Smith. To leave a voice message, press 1 now”

5. Press the appropriate telephone key to stop recording the voice portion of the greeting.

6. Hang up the handset. If you use a TTY device with an acoustic coupler, place the handset
into the coupler

7. Press the appropriate telephone key to resume recording

8. When you see the GA prompt, type your TTY greeting.

The following message is an example of what you can type:

“John Smith is not available. Please leave a message after you receive the GA prompt.
When you finish, you can hang up or press 1 for more options”

9. Press the appropriate telephone key immediately to stop recording.

10. Press the appropriate telephone keys to accept, delete, or record the greeting again.

Place a call to another TTY user
A caller can use a telephone or a TTY device to place a telephone call to a user who uses a TTY
device.
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Troubleshooting the teletypewriter user interface
This topic describes how to correct common problems that can occur on TTY-enabled Messaging
systems. If these suggestions do not correct the problem, contact your administrator.

Note:

The TUI you use determines the telephone key that you press.

Typographical errors and missing characters in Messaging
messages

Messaging transmissions might not be loud enough for your TTY device.

Potential solution
Procedure

1. On some TTY devices, you can adjust the sensitivity of the device in order to detect weak
signals.

For more information about setting the device sensitivity to high, refer to the user guide for
your TTY device.

2. Alternatively, you can increase the volume of the transmission while Messaging plays a
message. Dial the appropriate telephone key for your TUI.

Note:

Do not try to increase the volume while Messaging plays prompts, or presents a menu.

Messaging does not respond to your commands or menu
selections

You might be sending “Baudot” TTY tones instead of the “touchtones” that Messaging requires for
command entries and menu selections.

The Baudot tones produced by TTY devices and the touchtones produced by a telephone when
dialing a telephone number are different. Many TTY devices that can generate touchtone signals to
dial telephone numbers switch automatically to TTY mode after dialing the number.

Potential solution
Procedure
Use the TTY device with a standard telephone that is dialpad-equipped, or use the TTY device with
the Avaya IP Softphone.

Troubleshooting the teletypewriter user interface

December 2014 Using Avaya Aura® Messaging R6.3     67
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya Aura® Messaging R6.3


System does not respond to the telephone keys that you press
While Messaging transmits text to your TTY, the system does not respond to the telephone keys
that you press. In other words, you have to wait until Messaging stops transmitting before it
responds to your touchtone commands.

Messaging transmissions can be so loud that Messaging cannot detect your touchtone signals.

Potential solution
Procedure

1. After Messaging transmits a message, lower the volume of the transmissions.

2. Press the appropriate telephone key for your TUI.

Note:

Do not try to lower the volume while Messaging plays prompts or presents a menu.

The TTY displays random characters, numbers, and punctuation
marks rather than meaningful text

Possible cause: Your TTY device is not synchronized with the Messaging system. Specifically,
Messaging is in letters mode while your device is in figures mode.

Potential resolution
About this task
Depending on the type of TTY device you use, you can re-synchronize your TTY device with
Messaging in the following ways:

Procedure
1. Press the Spacebar key.

2. Press the LETTERS key.

3. Type any letter.

Note:

If you see letters where you expect to see numbers, press the FIGURES key on your
TTY device, or type any digit.
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Users see random characters, numbers, and punctuation marks
on recorded messages

When TTY users read a message or a conversation that you recorded using Messaging, they see
random characters, numbers, and punctuation marks.

Possible cause: Your TTY device is not synchronized with the Messaging system.

Potential solution
About this task
To synchronize your TTY device with Messaging, use one of the following methods before you type
in any content:

Procedure
1. If your recording starts with a letter, press the LETTERS key before you type in any content.

2. If your TTY device does not have a LETTERS key, type a slash (/), press Spacebar a few
times, and type the content.

3. If your recording starts with a figure, press the FIGURES key and type in your content.

4. If your TTY device does not have a FIGURES key, type the letter x, press Spacebar a few
times, and then type in your content.

Note:

In all cases, wait for the GA prompt before you start to type.
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